Using the Epilog Fusion Edge 24 v1.2


Using the Epilog Fusion Edge 24 Laser Cutter
Overview of the Laser Cutter
Midland Public Library (MPL) operates a Fusion Edge 24 laser cutter which is manufactured by the Epilog Corporation and uses a 60W, air cooled, CO2 laser.  The laser cutter can engrave, score, and/or cut designs and shapes on flat and cylindrical surfaces using a wide range of materials.
Materials for laser cutting must either be provided by, or approved by, MPL in advance – do not plan on using your own materials without approval.  MPL allows the use of only the following materials:
	MPL Laser Cutter Allowed Materials

	
	Engrave
	Score
	Cut
	Comments

	Acrylic
	Yes
	Yes
	Yes
	Cut up to 3/8” (9.5 mm) thick.  May require 2 passes.

	Birch Plywood
	Yes
	Yes
	Yes
	See above.

	Walnut Plywood
	Yes
	Yes
	Yes
	See above.

	Solid Maple
	Yes
	Yes
	Yes
	See above.

	Solid Oak
	Yes
	Yes
	Yes
	See above.

	Solid Walnut
	Yes
	Yes
	Yes
	See above.

	Cork
	Yes
	Yes
	Yes
	See above.

	Glass
	Yes
	Yes
	No
	

	Paper
	Yes
	Yes
	Yes
	

	Matboard
	Yes
	Yes
	Yes
	

	Cardboard
	Yes
	Yes
	Yes
	

	Rubber (laser grade)
	Yes
	Yes
	Yes
	

	Felt (wool)
	Yes
	Yes
	Yes
	

	Leather (untreated/unstained)
	Yes
	Yes
	Yes
	

	Cotton Fabric
	Yes
	Yes
	Yes
	

	Denim Fabric
	Yes
	Yes
	Yes
	

	Anodized Aluminium
	Yes
	Yes
	No
	Removes anodized layer.



A list of prohibited materials is shown in Appendix A.  Use of these materials is a safety concern and may also cause damage to the machine.

If in doubt, ask!

The laser cutter can cut or engrave flat material up to 24” x 24” (610mm x 610mm).  The maximum thickness of material that can be loaded into the machine is 10” (254mm).  The maximum practical thickness for cutting material is around 1/4” – 3/8” (6.0mm – 9.5mm).


Features of the Fusion Edge 24
1. The Edge 24 comes with its own control software which is implemented in two modules – the Epilog Job Manager and the Epilog Dashboard.   The Job Manager is used as a database to operate the machine in a production environment and typically is not used during normal MPL operations.  The Dashboard is the main software module that allows a user to fully develop and control the laser process of a specific graphic image, project, etc.  After all of the Epilog software has been installed and configured, all applications on the host computer ‘see’ the Edge 24 as ‘just another’ printer.
2. Built-in high resolution real-time video cameras.  The two cameras create a single image continuously visible within the Dashboard to show the user the location of the workpiece so that project files may be aligned correctly. 
3. The Dashboard allows some degree of project file manipulation.  Once the graphic file has been printed, i.e., sent to the Dashboard, you can then:
a. Align the project with the workpiece,
b. Scale the project,
c. Ungroup the image and manipulate individual elements of the graphic,
d. Copy the project to multiple places on the workpiece.
4. Pre-defined laser parameters.  For a wide range of acceptable materials the Dashboard provides an initial setting of the laser parameters, i.e., speed, power and frequency of the laser, to control the cutting, scoring and/or engraving process for the work piece material.  Testing of the laser parameters on scrap material is always advised.
5. A red siting laser pointer is mounted in-line with the cutting laser and is used to show where the laser will actually cut the workpiece material.
6. A resolution of 75 – 1200 dpi (dots per inch) for engraving surfaces together with advanced ‘dithering’ software to improve engraved image quality.
7. A rim-drive rotary attachment for marking and engraving cylindrical objects.  The two video cameras are not supported when using the rotary attachment.  Careful consideration must be given to graphic image preparation when engraving on non-cylindrical surfaces.   Only plug-in and unplug the rotary attachment with the power to the laser cutter turned off.  Detailed instructions for using the rotary attachment are provided in the Fusion Edge manual, page 142 onwards.


Overview of Process to Create a Project
1. Obtain or create the files required for the project.  These may be:
a. Photos from a digital camera or the internet,  i.e., .jpg files, to be engraved,
b. Graphic files from the internet or created by the user, i.e., .png files, to be engraved,
c. Lines, borders, profiles, etc. files from the internet or created by the user, i.e., .svg files, to be cut or scored by the laser.
Image files may be referred to as raster files and files for cut lines may be called vector files.  The Edge 24 behaves as a printer so that a .pdf file sent to it will cause an image to be engraved.  Typically the Edge 24 will engrave a file.  To cut or score the lines in the file then they must have specific characteristics recognized by the laser cutter.
2. Place the flat workpiece on the lattice inside the laser cutter.  Ensure the workpiece is level.
3. Using the touch screen control panel on the Edge 24, auto focus the laser on the workpiece.
4. Using your preferred graphics design software and the files from step 1, create your project.  MPL recommends the use of Inkscape as a graphics design package as it is free and capable of working with all required file types.  Inkscape is installed on the MakerPlace computers.
5. Print the project from the graphics software selecting the Epilog Edge 24 as the printer.
6. This will cause the Dashboard software to open with your project and workpiece shown. 
7. Within the Dashboard software align your project image with the workpiece using the superimposed image from the camera as a guide.
8. Select the material of the workpiece and confirm all of the parameters controlling the laser cutter for cut, score and/or engrave.  Ensure that all cut and engrave processes will be performed in the correct sequence and that the engraving will be done in the preferred direction.
9. Press ‘Print’ on the Dashboard and send the project as a job to the Edge 24.
10. If required, use the button on the Edge 24 control panel to move the siting laser around the perimeter of the project to determine if the alignment is correct.
11. Start the laser exhaust fan using the small rotary knob near the Edge 24.
12. Start the air assist pump, using the small rocker switch on the pump, to ensure particles and debris are cleared directly from the cutting area.
13. Ensure the cover is closed and start the job from the control panel of the Edge 24.
14. When the job has finished wait a few seconds for the fumes to clear and switch off the exhaust fan and the air assist pump.
15. Remove the finished project and scrap material.  Clean inside with vacuum cleaner if required.
Notes:
Always focus the laser immediately after you load your work piece material.  Unless the laser is focused correctly the image of your workpiece in the Dashboard software will not be positionally accurate.
Inkscape will typically save files with a .svg extension even though they contain images.

Control Panel
The main user controls on the laser cutter are the touch screen control panel, the Go/Stop button and the Joystick.
[image: ]
[image: ] - Displays the Jobs sent to the laser cutter from the Dashboard.  The latest Job sent is always on the top of the list and ‘active’.  Highlight a Job and press the Go button and the machine will start.
[image: ] - Delete a selected Job from the Job menu.
[image: ] - Settings menu.  Nothing to see here.
[image: ] - Indicates the current status of the machine.
[image: ] - Return to home position (back left corner) and put the laser cutter in idle status.
[image: ] - Control of the Z-axis (up and down) using the Joystick.  Use this option to auto focus the laser after loading your workpiece.  Ensure there are no obstructions when raising the bed of the machine.
[image: ] - Switch on or off the siting laser.
[image: ] - Moves the laser head in the X-axis and Y-axis directions using the Joystick.  Ensure the laser head will not hit anything when it moves. 
[image: ] - Moves the laser head around the perimeter of the currently active job.
Once the laser is focused remember to deselect the Z- axis button.  If not, it is very easy to move the joystick by mistake and the laser will go out of focus.

The Dashboard Software
Below is the original project developed in Inkscape annotated with the file types and sources of the graphics.  All vectors (lines) were produced within Inkscape.
[image: ]
The .jpg image, the .png image and the ‘closed’ text will be engraved on the Edge 24.  The .jpg file has been processed from its original form to one more suited for engraving.  See below.
The ‘open’ text and the other three colored vector lines will be cut/scored, depending upon the laser parameters used, by the Edge 24.
Although not shown here, an imported .pdf file will typically be engraved due to line widths and ‘transparency’ of the image.  See 2.0 below.
When this file is printed from Inkscape using the Epilog Engraver (Edge 24) as the selected printer then the Dashboard software displays the following;
[image: ]
1. Notice the pink lines and shaded area showing where the ‘page size’ of the project has been located on the Edge 24.  This page size is the document size used in Inkscape and the project graphic is shown positioned on the page as drawn in Inkscape.  If the project graphic is moved outside of these pink lines then the Edge 24 will not ‘print’ it.  Move the pink page size lines to include where you want to print your project on the workpiece.  To avoid this step then use a document in Inkscape that is 24” x 24” – the size of the Edge 24 ‘page’.
2. On the right, under Processes, you will see two boxes, Engrave and Vector, which illustrates which parts of the project will be engraved and cut/scored.  The Dashboard will designate any part of the project a vector cut line if it is drawn solid (zero transparency) and equal to, or thinner than, 0.003” (0.075mm) in width.  In Inkscape, once an object has been selected, then Fill and Stroke/Stroke style designates the line’s thickness of the graphic.  This includes Inkscape text that has been converted (within Inkscape) to outline or ‘open’ text.
3. To zoom in on your project for better viewing then press the ‘To Fit’ button at the top left of the screen.
4. The Dashboard shows all the elements of the project graphic grouped, i.e., one item for easy moving around and sizing.  Selecting the single element and pressing the ungroup icon on the left will allow each element to be moved around and sized individually in case your original project was not quite correct.
5. Selecting your project and right clicking on the mouse shows more options to edit the project including copy and pasting, flipping horizontally, vertically, etc.
6. To load the laser parameters for the workpiece material then, for each Process box, press the top right icon ‘Import Material Settings’ and select your material.  For vector processes ensure you have selected the correct thickness of material.
7. Clicking anywhere within the header of each of the Process boxes will expand the box as shown below;

[image: ]
8. Within this box;
a. The default laser parameters may be adjusted.
i. Speed – the slower the speed, the deeper the cut or engraving.
ii. Power – the higher the power, the deeper the cut or engraving.
iii. Frequency – only active on Vector processes.  The lower the frequency the cooler the cut and less charring will occur.  High frequency tends to polish the cut edge on plastics – like acrylic.
b. For engraving photo images then the Resolution should be set to the same dpi as the image within your graphics package (Inkscape).  600dpi is recommended for engraving photos.  See below.
c. Set the Dithering to the required value – Jarvis or Stucki are fine.  Dithering is a complex subject.  See Epilog Fusion Series manual, p125.
d. The Direction arrow in the lower right hand corner should be set to point upwards for quality engraving.  This arrow defines the direction in which the Edge 24 will create the engraving.  The Edge 24 always engraves using ‘left to right’ travel of the laser but can either start at the bottom or top of the image.  Starting at the bottom and moving upwards to the back of the machine allows the smoke and debris from the engraving process to be removed from the back of the machine without passing across the newly engraved surface of the workpiece and potentially marking it.
9. Clicking inside the Vector Process box to expand it and pressing Split by Color will result in the following;
[image: ]
10. Here the Dashboard software has split the single Vector Process into separate Processes based upon the drawn color of the vector line.  Inkscape allows the color of a line to be changed using Fill and Stroke/Stroke paint.    Here the laser parameters may be changed per line color so that some lines may be used to cut and others used to score (less laser power) the workpiece.  Also on this screen it is possible to drag and drop each color process block up or down to determine the order of cutting and scoring the workpiece.  Typically the last cut of a project is to remove the finished item from the workpiece material.  The Edge 24 executes the processes from the top to the bottom of the process list on the right.  Engraves are always at the top of the list.
11. Although less common, it is also possible to split the Engrave process by color and/or by line width.  In this example the original file for the text ‘Mount’ has been colored red allowing it to be split from the black/white .jpg and .png images and have its own process.  See below.
12. If not using the color of the lines to control the order of cutting then the Edge 24 will use the Vector Sorting method set within the Process box.  The default is ‘inside (lines) to outside (lines)’.
13. The Process box also contains a Cycles setting to set the number of passes, engraving or cutting, the user requires for that element of the project.
14. To verify what will be engraved and what will be cut (in case the engraving processes and cut processes are on top of each other) then either inspect the small graphic at the side of the Process box or select either the Engrave (only) or Vector (only) radio button on the top right of the screen and view the screen.
15. The Edge 24 will only ‘print’ one file at a time from Inkscape/Dashboard.  If a second project is sent to the Dashboard then the first project will be simply overwritten – the two projects will not be combined into one Job.  If the project requires multiple input files and a graphics editor like Inkscape can’t be used, then each file will have to be sent to the Dashboard and printed on the Edge 24 before the next file is sent to the Dashboard.  This process is akin to printing on the same piece of paper and will require careful consideration of the alignment of each file.
16. Pressing the Print button on the lower right corner will send this project to the Edge 24 as a job to be run.
[image: ] 



To Prepare a Photo for Engraving (suggested)
Use the following steps to prepare a .jpg photo prior to printing it directly to the Edge 24 or importing it into Inscape as part of a larger project.  The steps can typically be done using your favorite photo editor software or they can be done using Inkscape.  As with any graphic process the quality of the output is always heavily dependent upon the quality of the original image, i.e., in focus, no strong shadows, good color balance, etc. 
1. Find a suitable photo.  Strong contrast between the texture of the subject and the background is ideal.  For example, a photo of a dog or cat against a grass background will produce a poor engraving as it will be difficult to distinguish the animal’s fur from the grass. 
2. Crop and/or size the photo to the requirements of your project.
3. Remove any background objects in the image as desired.
4. Convert to a greyscale image.  In Inkscape use Filters>Color>Greyscale.
5. Edit photo to make dark areas lighter.  Increase the contrast in low contrast areas. 
6. Save photo at 600 dpi.
7. Sharpen image.  In Inkscape use Filters>Image Effects>Sharpen/Sharpen More.
8. Save the image as a .jpg or .png file type.
9. Print the photo to the Edge 24.
10. Do not change the size of the photo using the Dashboard software.  Go to step 2. above to start again if the photo is the wrong size.
11. Import the material parameters.
12. Ensure that the dpi set on the Edge 24 in the Engrave Process box is the same as that used on the photo (600 dpi).
13. Select your dither pattern.  Select ‘none’ if the photo has been dithered already.
14. Select Direction of engraving from ‘bottom to top’.
15. [bookmark: _GoBack]Engrave on some test material and review the results.  Adjust the process as necessary.  Research the internet for other methods but typically the methods described there are dependent upon specific photo editing and graphic packages. 
MPL has installed PhotoLaser Plus (PLP) on the PC next to the Edge 24.  This software can be used to transform a photo ready for laser engraving.  Comprehensive instructions for PLP are supplied in the laser cutter folder.  Note:  this software can’t remove background objects from an original photo.
Costs
Lasering your designs at MPL costs $0.05 per square inch on materials the library provides, or $1.00 + $1.00 per hour on your own materials.
The laser within the Edge 24 has a finite operating life before it has to be replaced. 
Materials for laser cutting, vinyl cutting, and 3D printing must either be provided by, or approved by, MPL in advance – do not plan on using your own materials without approval.

Appendix A - Materials not to be Laser Cut or Engraved

	MATERIAL
	DANGER
	CONSEQUENCE

	PVC (Poly Vinyl Chloride, a.k.a. vinyl)) 
	Emits pure chlorine gas.

	Gas will ruin lens, corrode metal, and ruin motion control system.

	Pleather/Artificial leather 
	Emits pure chlorine gas.

	Gas will ruin lens, corrode metal, and ruin motion control system.

	Moleskin Notebooks 
	Emits pure chlorine gas.

	Gas will ruin lens, corrode metal, and ruin motion control system.

	Polycarbonate/ Lexan
	Cuts poorly, discolors, fire risk.
	This material absorbs infrared radiation, so the laser is very ineffective.

	ABS (Acrylonitrile butadiene styrene)
	Emits cyanide gas and melts into the machine.
	Abs tends to melt, making a mess. It also has a higher chance of catching fire.

	HDPE (High Density Polyethylene)
	Catches fire and melts.

	It melts, tending to make a mess and ruin the material tray.

	Polystyrene Foam
	Catches fire.
	It catches fire and it melts.
This is the #1 material that causes laser fires!!!

	Polypropylene Foam

	Catches fire.

	Like Polystyrene, it melts, catches fire, and the melted drops continue to burn and turn into rock-hard drips and pebbles.

	Fiberglass

	Emits fumes.

	It's a mix of two materials that can’t be cut.
Glass (engrave, but not cut) and epoxy resin (fumes).

	Coated Carbon Fiber

	Emits noxious fumes.

	A mix of two materials.  Thin carbon fiber mat could be cut, with some fraying - but not when coated.

	Mirrored surfaces
	
	Will not work.

	Wood that has been coated, fumigated, pressure treated or stained
	Potential to emit noxious fumes.
	

	Any painted or varnished material
	Potential to emit noxious fumes.
	

	Any powder

	
	Compressed air from laser head will blow it away.

	Butane lighters
	Explode, catch fire.
	

	Gasoline or other flammable liquid containers
	Explode, catch fire.

	

	People / Animals
	Catch fire, burn, blind.
	Let’s be serious!
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